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1.  Introduction 
 

1.1 Add-on Module RF-TIMBER Pro 
RF-TIMBER Pro is one of the add-on modules integrated in the RFEM user interface. Use the 
program to perform the design of timber members and sets of members, based on the de-
sign concepts of DIN 1052:2008, Eurocode 5 (EN 1995-1-1:2010-12 + A1:2008) or  
SIA 265:2003. Country-specific regulations concerning Eurocode 5 are taken into account 
by national annexes (NAs). You can take advantage of the national documents that are al-
ready implemented, but you can also define your own limit values or create new NAs. The 
list shown on the left includes the NAs available for EN 1995-1-1 and is constantly being 
expanded. 

RF-TIMBER Pro performs all typical ultimate limit state designs as well as stability and de-
formation analyses. The stability analysis is carried out according to the equivalent member 
method or the second-order analysis. When the equivalent member method is applied, the 
program considers intended axial compression along the grain, bending without compres-
sion force, bending and compression, shear from transverse force as well as bending and 
tension. Fire resistance is designed according to DIN 4102-4, EN 1995-1-2 or SIA 265. 

In timber construction the serviceability limit state represents an important factor for struc-
tural calculations. Therefore, you can assign load cases, groups and combinations individu-
ally to various design situations. The limit deformations are preset, for example by the na-
tional annex, and can be adjusted, if necessary. In addition, it is possible to specify refer-
ence lengths and cambers that will be considered accordingly in the design. 

As RF-TIMBER Pro like other add-on modules is completely integrated in RFEM, the design-
relevant input data is already preset when you have started the program. Subsequent to the 
design, you can use the graphical RFEM user interface to evaluate the results. The entire de-
sign process is presented properly and in a consistent form in the global printout report. 

Finally, RF-TIMBER Pro offers you an automatic cross-section optimization including export 
option for transferring modified cross-sections to RFEM. Separate design cases allow for a 
flexible analysis of several structural components in complex structures. 

We hope you will enjoy working with RF-TIMBER Pro. 

Your team from ING. SOFTWARE DLUBAL 

 
 

NAs according to EC 5 
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1.2 RF-TIMBER Pro - Team 
The following people were involved in the development of RF-TIMBER Pro: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
Dipl.-Ing. (FH) René Flori 

Ing. Jiří Hanzálek 
Dipl.-Ing. (FH) Bastian Kuhn 

Programming 
Ing. Zdeněk Kosáček 
Dipl.-Ing. Georg Dlubal 

Ing. Roman Svoboda 
DiS. Jiří Šmerák 

Cross-section and material database 
Ing. Ph.D. Jan Rybín  Jan Brnušák 

Program design, dialog figures and icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Program supervision 
Ing. Jiří Hanzálek 
Zdenek Kodera 

Dipl.-Ing. (FH) Bastian Kuhn 
 

Manual, help system and translation 
Dipl.-Ing. (FH) Bastian Kuhn 
Dipl.-Ing. (FH) Robert Vogl 
Dipl.- Ü. Gundel Pietzcker 

Mgr. Petra Pokorná 
Jan Jeřábek 

Technical support and quality management 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. (BA) Sandy Matula 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. (FH) Matthias Entenmann 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 

Dipl.-Ing. (FH) Bastian Kuhn 
M.Sc. Dipl.-Ing. (FH) Frank Lobisch  
Dipl.-Ing. (FH) Alexander Meierhofer 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Robert Vogl 

1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation and printout are de-
scribed in detail in the manual of the main program RFEM. The present manual focuses on 
typical features of the add-on module RF-TIMBER Pro. 

The descriptions in this manual follow the sequence of the module's input and results tables 
as well as their structure. The text of the manual shows the described buttons in square 
brackets, for example [Apply]. At the same time, they are pictured on the left. Expressions 
appearing in dialog boxes, tables and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you don’t find what you are look-
ing for, please check our website www.dlubal.com where you can go through our FAQ 
pages by selecting particular criteria. 

http://www.dlubal.com/
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1.4 Open the Add-on Module RF-TIMBER Pro 
RFEM provides the following options to start the add-on module RF-TIMBER Pro. 

Menu 
To start the program in the menu bar, 

point to Design - Timber on the Additional Modules menu, and then select  
RF-TIMBER Pro. 

 
Figure 1.1: Menu Additional Modules → Design - Timber → RF-TIMBER Pro 

Navigator 
To start RF-TIMBER Pro in the Data navigator, 

select RF-TIMBER Pro in the Additional Modules folder. 

 
Figure 1.2: Data navigator: Additional Modules → RF-TIMBER Pro 
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Panel 
In case RF-TIMBER Pro results are already available in the RFEM structure, set the relevant 
RF-TIMBER Pro design case in the load case list of the RFEM menu bar. Use the button [Re-
sults on/off] to display the design criteria on the members graphically. 

When the results display is activated, the panel appears showing the button [RF-TIMBER 
Pro] which you can use to open the add-on module. 

 

Figure 1.3: Panel button [RF-TIMBER Pro] 
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2.  Input Data 
The design cases are defined in several input tables. For members and sets of members you 
can use the [Pick] function to select them graphically. 

When you have started RF-TIMBER Pro, a new window opens where a navigator is displayed 
on the left, managing all tables that can be selected currently. The pull-down list above the 
navigator contains the design cases that are already available (see chapter 7.1, page 54). 

If you open RF-TIMBER Pro in an RFEM structure for the first time, the module imports the 
following design relevant data automatically: 

• Members and sets of members 

• Load cases (LC), load groups (LG) and load combinations (CO) 

• Materials 

• Cross-sections 

• Internal forces (in background, if calculated) 

To select a table, click the corresponding entry in the RF-TIMBER Pro navigator or page 
through the tables by using the buttons shown on the left. You can also use the function 
keys [F2] and [F3] to select the previous or subsequent table. 

Click [OK] to save the entered data and quit the add-on module RF-TIMBER Pro. When you 
click [Cancel], you quit the module but without saving the data. 

2.1 General Data 
In table 1.1 General Data, you select the members, sets of members and actions that you 
want to design. The tabs are managing the load cases, groups and combinations for the 
different designs. 

2.1.1 Ultimate Limit State 

 
Figure 2.1: Table 1.1 General Data, tab Ultimate Limit State 
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Design of 
The design can be carried out for Members as well as for Sets of members. If you want to 
design only selected objects, clear the All check boxes. Then you can access the two input 
fields to enter the numbers of the relevant members or sets of members. To select the ob-
jects graphically in the RFEM work window, use the [Pick] button. The list of the preset 
member numbers can be selected quickly by double click and overwritten by entering the 
data manually. 

In case no set of members has yet been defined in RFEM, you can create a new set of mem-
bers in RF-TIMBER Pro by using the [New] button. The dialog box that you already know 
from RFEM appears where you can specify the data for a new set of members. 

When you design a set of members, the program determines the extreme values of the de-
signs of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. Subsequent to the calculation, 
the additional results tables 2.3 Design by Set of Members, 3.2 Governing Internal Forces by 
Set of Members and 4.2 Parts List by Set of Members will be displayed. 

According to Code / Annex 
In the selection field on the top right, you specify the standard by which you want to per-
form the design. The following codes can be selected: 

• DIN 1052:2008-12 

• EN 1995-1:2004-11 

• SIA 265:2003 

When you select the European standard Eurocode 5, you also have to specify the national 
annex whose parameters will be used for the design and the deformation's limit values. 

Use the [Edit] button to open a dialog box where you can check and adjust, if necessary, 
the parameters of the standard or the currently selected NA. The dialog box is described in 
chapter 2.1.4 on page 12. 

Existing Load Cases / Load Groups and Load Combinations 
These two dialog sections list all load cases, groups and combinations defined in RFEM that 
are relevant for the design. Use the button [] to transfer selected load cases, groups or 
combinations to the list Selected for Design on the right. You can also double-click the 
items. To transfer the complete list to the right, use the button []. 

When load cases or combinations are marked by an asterisk (*) like load case 11 in Figure 
2.1, they cannot be calculated. Those load cases are cases without load data or pure imper-
fection cases. 

Please note that only load combinations for which the program can determine clear minima 
and maxima (which means alternative combinations with the superposition criterion Per-
manent) are allowed for the design. When you select an unacceptable load combination, 
the following error message will be displayed: 

 
Figure 2.2: Warning appearing when an unallowable load combination is selected 
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A multiple selection of load cases is possible by means of the common Windows function 
holding down the keyboard key [Ctrl]. In this way, you can transfer several load cases simul-
taneously. 

Selected for Design 
The column on the right lists the loads selected for the design. Use the button [] to re-
move selected load cases, groups or combinations from the list. You can also double-click 
the entries. With the button [], you can transfer the entire list to the left. 

The analysis of an enveloping Or load combination is often carried out more quickly than 
the design of all load cases and groups that have been globally set. However, please be 
aware of the restriction mentioned above: The load combination must contain only load 
cases, groups or combinations that are superimposed with the Permanent criterion. Fur-
thermore, when you design a load combination, please keep in mind that it is difficult to 
see the effect of the actions contained in a CO. 

2.1.2 Serviceability Limit State 

 
Figure 2.3: Table 1.1 General Data, tab Serviceability Limit State 

Existing Load Cases / Load Groups and Load Combinations 
In these two sections, all load cases, load groups and load combinations are listed that have 
been created in RFEM. 

Selected for Design 
Adding and removing load cases, load groups and load combinations is described in the 
previous chapter 2.1.1. 

 



2  Input Data 

 

 

11 Program RF-TIMBER Pro © 2011 Ing. Software Dlubal 

Design Combination 
It is possible to assign different limit values for the deflection to the individual load cases, 
groups and combinations. First, select the relevant action in table Selected for Design. To 
assign the selected design combination, click the blue checkmark button []. The following 
criteria are available for EN 1995-1-1: 

• winst for a permanent action (SC) 

• wfin for a leading variable action (S1) 

• wfin - wc for a leading variable action with camber (S2) 

The limit values of the deformations are specified in the standards or NAs and can be ad-
justed for the different design combinations in the corresponding parameter settings (see 
Figure 2.5, page 13). 

The reference lengths that are decisive for the serviceability limit state design are managed 
in table 1.8 (see chapter 2.8, page 27). 

Comment 
In this input field, you can enter user-defined notes describing for example the action com-
binations of the current design case. 
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2.1.3 Fire Resistance 

 
Figure 2.4: Table 1.1 General Data, tab Fire Resistance 

Existing Load Cases / Load Groups and Load Combinations 
In these two sections, all load cases, load groups and load combinations are listed that have 
been created in RFEM. Thus, it is required for the fire protection design that the superposi-
tion in an appropriate combination must have been done already in RFEM. 

Selected for Design 
Adding and removing load cases, load groups and load combinations is described in chap-
ter 2.1.1. The load selection must include the actions and combinations that have been cre-
ated in RFEM specifically for the fire protection design. 

The fire protection design is performed by means of a reduced cross-section. In the dialog 
box National Annex Settings (see Figure 2.5) as well as in the Details dialog box, tab Fire Re-
sistance (see Figure 3.4, page 32), you can define detailed specifications for the fire re-
sistance design. 

2.1.4 Standard Parameters 
With the lists of the selection fields in the upper right corner of table 1.1 General Data, you 
can define the standard or NA whose parameters you want to apply to the design and the 
limit values of the deformation. 

Use the [Edit] button to check the preset parameters of the active code or NA. If necessary, 
you can adjust the settings (see Figure 2.5). 

To create a user-defined national annex, use the [New] button. 

The buttons in the bottom left corner of the NA Settings dialog box allow you to save modi-
fied values as default setting. Furthermore, you can use the buttons to import saved pa-
rameters or to restore the program presettings. 

A user-defined national annex can be deleted by using the [Delete] button. 
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Moreover, all input tables provide the button [Code] or [Nat. Annex] which you can use any 
time to access the Settings dialog box. 

A three-tab dialog box opens. 

General 

 
Figure 2.5: Dialog box National Annex Settings, tab General 

Partial and modification factors, limit values of deformations 
The dialog sections above allow you to check and, if necessary, to adjust the Partial Factors 
and Limit Values of Deformations as well as the Modification Factors kmod for the different 
design situations. 

In addition, it is possible to change the Maximum Cut-to-Grain Angle, if required. 

Data for fire protection 
The design for the event of fire is performed with an ideal remaining cross-section. The pa-
rameters Charring Rate βn and Increased Charring d0 used to determine the remaining cross-
section are predefined for the material types coniferous, glued-laminated and leafy timber 
but can be adjusted, if necessary. 

The Factor kfi is used for the determination of the 20%-quantile of the strength and stiffness 
from the 5%-quantile. 
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Other Settings 
In the second tab of the dialog box National Annex Settings you find different factors sig-
nificant for the design. 

 
Figure 2.6: Dialog box National Annex Settings, tab Other Settings 

Used Codes 
The third tab of the dialog box National Annex Settings informs you about the codes ac-
cording to which the design will be performed. 

 
Figure 2.7: Dialog box National Annex Settings, tab Used Codes 
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2.2 Materials 
The table is subdivided into two parts. In the upper part, the materials used for the design 
are listed. In the Material Properties section below, the properties of the current material, 
i.e. the table row currently selected in the upper section, are displayed. 

Materials that won't be used in the design appear gray in color. Materials that are not al-
lowed are highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces in RFEM are de-
scribed in detail in chapter 5.3 of the RFEM manual. The design relevant material properties 
are stored in the global material library and preset automatically. 

To change the units and decimal places of material properties and stresses, select Units and 
Decimal Places on the module's Settings menu (see chapter 7.4, page 59). 

 
Figure 2.8: Table 1.2 Materials 

Material Description 
The materials defined in RFEM are already preset. If you modify the Material Description 
and the manually specified entry is listed in the material library, RF-TIMBER Pro will import 
the corresponding material properties. 

You can modify the material by using the list: Place the cursor in a table row of column A, 
and then click the button [] or use the function key [F7] to open the list shown on the left. 
Subsequent to the selection, the program will update the design-relevant properties. 

In accordance with the design concept of the timber codes, the list includes only materials 
of the Timber category. The import of materials from the library is described below. 

Basically, it is not possible to edit the material properties in RF-TIMBER Pro. Therefore, if you 
want to apply modified stiffnesses, you have to define a new material with the relevant 
characteristic values by entering new data in the material library (see chapter 5.3 in the 
RFEM manual). 
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Material Properties 
The partial safety factor γM represents the safety factor used to calculate the design values 
of the material stiffnesses. By means of this factor the program reduces the characteristic 
strength value for bending fm,k, tension parallel ft,0,k, tension perpendicular ft,90,k, compres-
sion parallel fc,0,k, compression perpendicular fc,90,k as well as for shear and torsion fv,k ac-
cording to Equation 2.1. 

The factor γM, as described for example in EN 1995-1-1, eq. (2.14), must be taken into ac-
count for the ultimate limit state design. 

M

k
modd

X
kX

γ
⋅=  

Equation 2.1: Reduction of characteristic strength by modification and partial safety factors 

The partial safety factor can be adjusted in the Settings dialog box, tab General (see Figure 
2.5, page 13). 

Material Library 
Numerous materials are available in the library. To open the library, 

select Material Library on the Edit menu 

or use the button shown on the left. 

 
Figure 2.9: Dialog box Material Library 

In the Filter Choice section, Timber is preset as material category. Select the timber grade 
that you want to use for the design in the list Material to Select. The corresponding proper-
ties can be checked in the dialog section below. 

Click [OK] or use the [↵] button to import the selected material to table 1.2 of RF-TIMBER 
Pro.  
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Chapter 5.3 of the RFEM manual describes in detail how materials can be filtered, added or 
rearranged. 

A member whose material neither belongs to the "timber" category nor corresponds to the 
selected standard cannot be designed. A corresponding message will be displayed when 
you start the calculation. 

2.3 Cross-sections 
This table lists the cross-sections that are relevant for the design. In addition, the table al-
lows for the definition of optimization parameters. 

 
Figure 2.10: Table 1.3 Cross-sections 

Cross-section Description 
The cross-sections used in RFEM are preset together with the assigned material numbers. 
Currently, the RF-TIMBER Pro design is restricted to rectangular and circular cross-sections 
of the category Solid Sections. 

It is always possible to modify the cross-sections for the design. The description of a modi-
fied cross-section is highlighted in blue. 

To modify a cross-section, enter the new cross-section description directly into the corre-
sponding table row. You can also select a new cross-section from the library. To open the 
library, use the button [Import Cross-section from Library] below the table. Alternatively, 
place the pointer in the respective table row and click the [...] button, or use the function 
key [F7]. The RFEM cross-section library appears, or better to say the cross-section table cor-
responding to the entry in the input field. 

The selection of cross-sections from the library is described in detail in chapter 5.13 of the 
RFEM manual. 
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Figure 2.11: Dialog box Solid Sections - Rectangle 

If the cross-sections set in RF-TIMBER Pro are different from the ones used in RFEM, both 
cross-sections are displayed in the graphic in the right part of the table. The designs for the 
cross-section selected in RF-TIMBER Pro will be performed with the internal forces of RFEM. 

Member with tapered cross-section 
For tapered members with different cross-sections at the member start and member end, 
the module displays both cross-section numbers, in accordance with the definition in RFEM, 
in two table rows. 

RF-TIMBER Pro is also able to design tapered members provided that the same cross-section 
type is defined for the start and the end cross-section. A taper design requires additional 
specifications in table 1.7 (see chapter 2.7, page 26). 

Info about cross-section 
The cross-section properties and stress points including numbering can be accessed in a 
separate dialog box: Select the relevant cross-section in table 1.3, and then click the [Info] 
button to open the dialog box Info about cross-section. 

 
Figure 2.12: Dialog box Info about cross-section 
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In the right part of the dialog box, the currently selected cross-section is displayed. The but-
tons below the graphic are reserved for the following functions: 

 

 
Table 2.1: Buttons of cross-section graphic 

Max. Design Ratio 
This table column is displayed only after the calculation. It is intended to be a decision sup-
port for optimizing the cross-sections. By means of the displayed design ratios and colored 
relation scales, you can see which cross-sections are hardly utilized and thus oversized, or 
extremely stressed and thus undersized. 

Optimize 
Each cross-section of the library can be improved by an optimization process. Using the in-
ternal forces from RFEM, the program determines the cross-section of the cross-section ta-
ble that comes as close as possible to the maximum stress ratio specified in the Other tab of 
the Details dialog box (see Figure 3.5, page 33). 

If you want to optimize a cross-section, tick the corresponding check box in column C or D. 
Recommendations for optimizing cross-sections can be found in chapter 7.2 on page 56. 

Remark 
This column shows remarks in the form of footers that are described in detail below the 
cross-section list. 

Button Function 

 Displays or hides the stress points. 

 Displays or hides the numbering of stress points. 

 Displays or hides the details of stress points. 

 Displays or hides the dimensions of the cross-section. 

 Displays or hides the principal axes of the cross-section. 

 Resets the full view of the cross-section graphic. 
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2.4 Load Duration and Service Class 
The load duration is indicated in table 1.4. In addition, it is possible to assign structural ob-
jects to different service classes to consider different climatic conditions for the design. 

 
Figure 2.13: Table 1.4 Load Duration and Service Class 

LC/LG/CO-Description 
The load case descriptions defined in RFEM make the classification easier. 

LC Type 
This table column shows the load cases' types of action according to the RFEM definition. 
They are the basis for the program's presettings in the subsequent table column. 

Load Duration Class LDC 
Both the ultimate and the serviceability limit state design require the assignment of loads 
and their superpositions to particular load-duration classes. The classification of actions is 
specified for example in [1] table 4 or [4] table 2.1. 

The load duration for load cases can be adjusted by using the list whereas load groups and 
load combinations are classified automatically taking into account the relevant leading ac-
tion. 

The modification factor kmod is determined by means of the LDC. The factor is also consid-
ered for the material stiffness. 

Coefficient kmod 
The impact of load duration and service class on the strength properties is taken into ac-
count by means of the modification factor (see [4] table 3.1). 

The factors can be checked and, if necessary, adjusted in the dialog box National Annex Set-
tings (see Figure 2.5, page 13). 
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Service Class SECL 
The classification into service classes makes it possible to assign strength parameters and to 
calculate deformations by taking into account environmental conditions. The service classes 
are specified for example in [4] section 2.3.1.3. 

By default the program assigns a standard service class to the entire structure. If you want 
to classify members or sets of members into different service classes, activate the selection 
field Different. To open the following dialog box, use the [Assign] button displayed to the 
right. 

 
Figure 2.14: Dialog box Assign Members/Sets of Members to Corresponding Service Classes 

The dialog box allows you to assign members and sets of members individually to service 
classes. The buttons are reserved for the following functions: 

Button Function 

 Select members/sets of members graphically for service class 

 Assign all members/sets of members to respective service class 

 Assign all members/sets of members not yet assigned to respective service 
class 

Table 2.2: Buttons in the dialog box Assign Members/Sets of Members to Corresponding Service Classes 
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2.5 Effective Lengths - Members 
Table 1.5 is divided into two parts in order to have a better data overview. The table in the 
upper part contains summarized information about the buckling length coefficients and the 
equivalent member lengths for local and lateral buckling of the members to be designed. 
The table part below shows detailed information for the member that is selected in the ta-
ble part above. 

 
Figure 2.15 Table 1.5 Effective Lengths - Members 

Changes to the buckling length coefficients can be made in the summarizing table in the 
upper part as well as in the detailed settings in the lower part. The specifications will be 
updated automatically in the respective other part of the table. The buckling length of a 
member can be defined also graphically by using the [Pick] function. 

The tree structure in the lower table part Settings contains the following parameters: 

• Cross-section 

• Length of member 

• Buckling Possible for member (cf. columns B, E and H) 

• Buckling about Axis y (effective lengths, cf. columns C and D) 

• Buckling about Axis z (effective lengths, cf. columns F and G) 

• Lateral-torsional Buckling (lateral buckling length coefficients, cf. columns H to J) 

It is possible to adjust the Effective Length Coefficient for the respective directions. Fur-
thermore, you can specify if you generally want to perform a buckling analysis or a lateral 
torsional buckling design. When the buckling length coefficient is modified, the equivalent 
member length will be adjusted automatically. 
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The buckling length of a member can also be defined in a dialog box that you open by click-
ing the button shown on the left. In the table, you find the button below the upper table 
part on the right. 

 
Figure 2.16: Dialog box Select Buckling Length Coefficient 

In the dialog box Select Buckling Length Coefficient, you can choose one of the four fa-
mous Euler buckling modes, define the buckling length coefficient manually or, if a calcu-
lated RF-STABILITY case is already available, select the governing eigenmode to determine 
the coefficient. 

Buckling Possible 
A stability analysis for flexural buckling and lateral-torsional buckling requires the ability of 
members to absorb compressive forces. Therefore, members for which such an absorption 
is not possible because of the defined member type (for example tension members, elastic 
foundations, rigid connections) are excluded from the RF-TIMBER Pro design in the first 
place. The corresponding rows are displayed in gray and a note is indicated in the Comment 
column. 

The table column Buckling Possible offers you a control option to classify members as com-
pression members or to exclude them from the design. Thus, with the check boxes in table 
column A and in the table Settings for Member, you decide for each member if the input 
fields for defining the buckling length parameters can be accessed. 

Buckling around Axis y or Axis z 
With the check boxes in the Possible table columns, you decide if a member has a risk of 
buckling about the axis y and/or z. These axes represent the local member axes, with axis y 
being the "strong" and axis z the "weak" member axis. The buckling length coefficients βef,y 
and βef,z for buckling around the strong or the weak axis can be selected freely. 

The position of the member axes can be checked in the cross-section graphic in table 1.3 
Cross-sections (see Figure 2.12). In the RFEM work window that you can always access by 
using the [Graphic] button, it is possible to display the local member axes by means of the 
Display navigator (see figure below). 
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Figure 2.17: Selecting the local member axis systems in the Display navigator of RFEM 

When buckling is possible about one or even both member axes, you can enter the buckling 
length coefficients as well as the buckling lengths in the columns C and D or F and G. The 
same is possible for the table Settings for Member. 

When you specify the buckling length coefficient βef, the program determines the effective 
length lef by multiplying the member length L by the buckling length coefficient. The input 
fields are interactive.  

To define the buckling length, you can use the [...] button appearing at the end of the lef 
input fields to determine the distance between two nodes graphically in the RFEM work 
window. 

Lateral Buckling Possible 
Table column H shows you for which members the program performs an analysis of lateral-
torsional buckling. 

The equivalent member length lef for this type of design can be defined manually or graph-
ically by the spacing of lateral supports. 

Below the Settings table you find the check box Set Inputs for Members No. If it is ticked, 
the settings entered afterwards will be applied to the selected or even to All members. 
Members can be selected by entering the member number or by selecting them graphically 
with the [Pick] button. This option is useful when you want to assign the same boundary 
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conditions to several members. Please note that settings that have been already defined 
cannot be changed subsequently with this function. 

Comment 
In the final table column, you can enter user-defined specifications for each member to de-
scribe for example the selected equivalent member lengths. 

2.6 Effective Lengths - Sets of Members 
Table 1.6 manages the effective lengths of sets of members. It is displayed only when you 
have selected at least one set of members for the design in table 1.1 General Data. 

 
Figure 2.18 Table 1.6 Effective Lengths - Sets of Members 

The structure of this table is similar to the previous table 1.5. Enter the effective lengths for 
local as well as for lateral-torsional buckling about the two principal axes of the set of 
members as described above. They determine the boundary conditions of the set of mem-
bers that is treated at large as equivalent member. 

The detail settings also specify the cross-sections that are contained in the set of members. 
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2.7 Tapered Members 
This table is only available when you have selected at least one member with different 
cross-sections on both member ends for the design in table 1.1 General Data. Here, you can 
check the definition criteria of the tapered members. 

 
Figure 2.19: Table 1.7 Tapered Members 

Cross-section 
Table columns A and B list the cross-sections that are defined on the Member Start and 
Member End. 

Length 
The length of the tapered member is also displayed for checking reasons. 

Cut-to-Grain Angle α 
RF-TIMBER Pro determines the cut-to-grain angle on the basis of the geometric conditions. 
The design equations used in the program apply only to the cutting angle α ≤ 20° for  
EN 1995-1-1 and SIA 265 or α ≤ 10° for DIN 1052. The limit values can be checked and, if 
necessary, adjusted in the dialog box National Annex Settings (see Figure 2.5, page 13). 

Grain Parallel to Edge 
In table column F you define the member edge to which the timber's grain direction is run-
ning parallel. The "top" or "bottom" edge can be clearly determined by means of the orienta-
tion of the local member axis z (see Figure 2.17). 

With Ridge 
When the check box is ticked in table column G With Ridge, the program performs the de-
sign for the maximum tension stresses perpendicular to the grain and shear from transverse 
force in the ridge cross-section, for example according to [1] condition (85) or [4] condition 
(6.50). 
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2.8 Serviceability Data 
This input table controls several settings for the serviceability limit state design. It is only 
available when you have set relevant entries in the Serviceability Limit State tab of table 1.1 
(see chapter 2.1.2, page 10). 

 
Figure 2.20: Table 1.8 Serviceability Data 

Reference to 
In column A, you decide whether you want to apply the deformation to single members, 
lists of members or sets of members. 

Member / Set No. 
In table column B, you enter the numbers of the members or sets of members that you 
want to design. You can also use the [Pick] function to select them graphically in the RFEM 
work window. The respective Reference Length will be entered automatically in column D. 
This column presets the lengths of the members, sets of members or member lists. If re-
quired, you can adjust these values after ticking the Manually check box in column C. 

Reference Length 
The reference lengths L are represented by the lengths of members or sets of members that 
are preset in table column D. If required, you can adjust these values after ticking the Man-
ually check box in column C. 

Direction 
Table column E defines the decisive direction for the deformation analysis. The member ori-
entations y and z are available for selection. 

Precamber 
If you want to consider a precamber wc, enter a value for the rise in table column F. 
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Beam Type 
The beam type is of vital importance for the correct application of limit deformations. In ta-
ble column G, you can select the girder to be a beam or a cantilever. 

The settings specified in the Serviceability tab of the Details dialog box determine whether 
the deformations are related to the undeformed initial structure or to the shifted ends of 
members or sets of members (see Figure 3.3, page 32). 

2.9 Fire Protection - Members 
Table 1.9 manages the fire resistance parameters of the members selected for the design. It 
is only available if you have set relevant entries in the Fire Resistance tab of table 1.1 (see 
chapter 2.1.2, page 10). 

 
Figure 2.21: Table 1.9 Fire Protection - Members 

Members No. 
Table column A contains the members that are taken into account by the design. Click the 
[...] button to use the pick function for a graphical member selection in the RFEM work 
window. 

Exposed to Fire - Four Sides 
RF-TIMBER Pro assumes that the cross-section is exposed to fire on all sides. If the assump-
tion is wrong and the given circumstances are different, clear the check box. Then it is pos-
sible to access the subsequent table columns. 

Exposed to Fire 
In case the charring does not occur on all four sides, you can define the cross-section sides 
exposed to fire in the columns C to F. The entries are required in order to determine the 
ideal remaining cross-section with the fire resistance settings specified in the Details dialog 
box (see chapter 3.1.4, page 32) correctly. 
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2.10 Fire Protection - Sets of Members 
The final input table 1.10 manages the fire resistance parameters of sets of members. It is 
displayed only when you have selected at least one set of members for the design in table 
1.1 General Data. 

 
Figure 2.22: Table 1.10 Fire Protection - Sets of Members 

The structure of the table is similar to the previous table 1.9. Enter the charring sides of the 
cross-section as described above. 
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3.  Calculation 
 

3.1 Detail Settings 
The individual designs are carried out by using the internal forces determined in RFEM. Be-
fore you start the calculation by clicking the [Calculation] button, it is recommended to 
check the design details. The corresponding dialog box can be accessed in each input und 
output table by using the [Details] button. 

The Details dialog box provides the following tabs: 

• Resistance 

• Stability 

• Serviceability 

• Fire Resistance 

• Other 

3.1.1 Resistance 

 
Figure 3.1: Dialog box Details, tab Resistance 

Consideration of Connections 
Often, zones near member connections show weakenings of the cross-section. It is possible 
to take into account this effect by a Reduction of limit tension stresses. 

The numbers of the relevant nodes can be entered manually or selected graphically by using 
the [Pick] button. 

The Connection length defines the zone on the member where reduced stresses are consid-
ered. In the input field below, enter the allowable Stress ratio in percentage. 

The maximum allowable stresses are applied outside the connection zone. If you want to 
reduce the allowable stresses also there, it is possible to enter a limit in the input field Stress 
ratio outside connections. 
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3.1.2 Stability 

 
Figure 3.2: Dialog box Details, tab Stability 

Stability Analysis 
You can select between equivalent member method and a design according to the second-
order analysis. 

When the equivalent member method is selected, the internal forces determined according 
to the linear static analysis will be used for the design. Thus, the effective lengths of the 
members and sets of members must be specified in table 1.5 and 1.6 to perform the stabil-
ity analysis. 

When the bearing capacity of a structural system is significantly affected by its defor-
mations, it is recommended to select a calculation according to the 2nd Order Theory. This 
approach requires additionally the definition of imperfections in RFEM taken into account 
for the load groups. 

Please note that you also have to perform the design for lateral torsional buckling for a cal-
culation according to the second-order analysis. Thus, the lengths for lateral-torsional buck-
ling of members or sets of members must be specified manually in table 1.5 or 1.6 Effective 
Lengths. In this way, we can make sure that the lateral buckling analysis will be performed 
with the appropriate factors (for example 1.0). 
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3.1.3 Serviceability 

 
Figure 3.3: Dialog box Details, tab Serviceability 

With the options in the dialog section Deformation Related to, you can decide if the maxi-
mum deformations are related to the undeformed initial structure or to an imaginary con-
nection line between member start and member end in the deformed system, which means 
the shifted ends of the member or member set. 

The limit deformations can be checked and, if necessary, adjusted in the dialog box Nation-
al Annex Settings (see chapter 2.1.4, page 12). 

3.1.4 Fire Resistance 
This tab manages the settings for the fire protection design. 

 
Figure 3.4: Dialog box Details, tab Fire Resistance 

The Fire classification can be selected directly or defined individually by specifying a time for 
the fire duration. 

The dialog box National Annex Settings manages the standard-specific parameters that are 
significant for the fire protection design (see Figure 2.5, page 13). 
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3.1.5 Other 

 
Figure 3.5: Dialog box Details, tab Other 

Cross-section Optimization 
In case the optimization is not targeted on the maximum design ratio of 100 %, you can 
specify another limit value in this input field. 

Check of Member Slendernesses 
The two fields allow for the input of limit values λlimit in order to define member slender-
nesses. It is possible to enter specifications separately for members with pure tension forces 
and members with bending and compression. 

In the results table 3.3, the limit values are compared to the real member slendernesses. 
This table is available only after the calculation (see chapter 4.8, page 42) when the corre-
sponding check mark has been set in the dialog section Display Result Tables to the right. 

Display Result Tables 
In this dialog section, you can select the results tables including parts lists that you want to 
display in the output. The individual results tables are described in chapter 4. 

Results table 3.3 Member Slendernesses is set inactive by default but can be activated for a 
specified evaluation by ticking the check box. 
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3.2 Start Calculation 
To start the calculation, click the [Calculation] button that is available in all input tables of 
the add-on module RF-TIMBER Pro. 

RF-TIMBER Pro searches for the results of the load cases, load groups and load combina-
tions that you want to design. If they cannot be found, the program starts the RFEM calcu-
lation to determine the design relevant internal forces. In this determination process, the 
calculation parameters preset in RFEM are applied. 

If cross-sections should be optimized (see chapter 7.2, page 56), the program determines 
the required cross-sections and performs the corresponding designs. 

It is also possible to start the calculation for RF-TIMBER Pro results in the RFEM user inter-
face. The add-on modules are listed like load cases and load groups in the dialog box To 
Calculate. To open the dialog box in RFEM, 

select To Calculate on the Calculate menu. 

 
Figure 3.6: Dialog box To Calculate 

If the RF-TIMBER Pro design cases are missing in the Not Calculated list, tick the check box 
Show Additional Modules below the list. 

To transfer the selected RF-TIMBER Pro cases to the list on the right, use the button []. 
Start the calculation by using the [Calculate] button. 

You can also use the list in the RFEM toolbar to calculate a design case directly: Select the 
RF-TIMBER Pro case and click the button [Results on/off]. 

 
Figure 3.7: Direct calculation of a RF-TIMBER Pro design case in RFEM 
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Subsequently, you can observe the calculation process in a separate dialog box. 

 
Figure 3.8: RF-TIMBER Pro calculation 
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4.  Results 
Table 2.1 Design by Load Case is displayed immediately after the calculation. The upper part 
of the results table shows you a summary of designs for the individual load cases, groups 
and combinations. The lower part contains detailed information about the cross-section 
characteristics, analyzed internal forces and performed designs for the load case that is se-
lected above. 

The designs are shown in the results tables 2.1 to 2.5, sorted by different criteria. The sub-
sequent tables 3.1 and 3.2 display the governing internal forces. Table 3.3 informs you 
about the member slendernesses. The two final results tables 4.1 and 4.2 contain the parts 
lists referring to members and sets of members. 

Each results table can be selected directly in the RF-TIMBER Pro navigator. You can also use 
the two buttons shown on the left or the function keys [F2] and [F3] to select the previous 
or subsequent table. 

Click the [OK] button to save the results. The add-on module RF-TIMBER Pro will be closed 
and you will return to the RFEM work window. 

Chapter 4 Results describes the different results tables one after the other. Evaluating and 
checking results is described in detail in chapter 5 Results Evaluation on page 45. 

4.1 Design by Load Case 

 
Figure 4.1: Table 2.1 Design by Load Case 

Description 
This column displays for information the descriptions of the load cases, groups and combi-
nations that are decisive for the respective designs. 
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Member No. 
Table column B shows for each designed load case, group or combination the number of 
the member that has the maximum design ratio. 

Position x 
The column shows the respective x-location for which the program has determined the 
member's maximum design ratio. For the table output, the program uses the following 
RFEM member locations x: 

• Start and end node 

• Partition points according to possibly defined member division 

• Member division according to specification for member results (Options tab of RFEM 
dialog box Calculation Parameters) 

• Extreme values of internal forces 

Design 
The output shows for each type of design and each load case, group or combination the 
design criteria according to the selected standard. 

The colored scales represent the design ratios due to the individual load cases. 

Design according to Formula 
This column lists the code's equations by which the designs have been performed. 

Design Situation 
Table column G contains information about the respective design-relevant Design Situation: 
ULS (ultimate limit state) or one of the three design situations for serviceability (SC, S1, S2) 
according to the specification set in table 1.1 General Data (see Figure 2.3, page 10) or ULS 
(fire protection). 

Load Duration Class 
This table column indicates the load duration classes defined in table 1.4 (see chapter 2.4, 
page 20). 

Coefficient kmod 
The final table column informs you about the modification factors by which the impact of 
load duration and service class on the strength properties is taken into account (see chapter 
2.4, page 20). 



4  Results 

 38 Program RF-TIMBER Pro © 2011 Ing. Software Dlubal 

 

4.2 Design by Cross-section 

 
Figure 4.2: Table 2.2 Design by Cross-section 

This table lists the maximum ratios of all members and actions selected for design, sorted 
by cross-sections. 

If a member is a tapered member, both cross-section descriptions are displayed in the table 
row next to the section number. 

4.3 Design by Set of Members 

 
Figure 4.3: Table 2.3 Design by Set of Members 
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This results table is displayed when you have selected at least one set of members for the 
design. The maximum design ratios are listed by sets of members. Table column Member 
No. shows the number of the member that has the maximum ratio within the set of mem-
bers. 

The results output by sets of members presents the design for an entire structural group 
(for example a chord) clearly in one results table. 

4.4 Design by Member 

 
Figure 4.4: Table 2.4 Design by Member 

This results table shows the maximum design ratios sorted by member numbers. The differ-
ent columns are described in detail in chapter 4.1 on page 36. 
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4.5 Design by x-Location 

 
Figure 4.5: Table 2.5 Design by x-Location 

This results table lists the maxima for each member at the locations x resulting from the di-
vision points defined in RFEM: 

• Start and end node 

• Partition points according to possibly defined member division 

• Member division according to specification for member results (Options tab of RFEM 
dialog box Calculation Parameters) 

• Extreme values of internal forces 



4  Results 

 

 

41 Program RF-TIMBER Pro © 2011 Ing. Software Dlubal 

4.6 Governing Internal Forces by Member 
This table displays for each member the governing internal forces that result in the maxi-
mum design ratio. 

 
Figure 4.6: Table 3.1 Governing Internal Forces by Member 

Location x 
The column shows the respective x-location where the member's maximum ratio occurs. 

Load Case 
This column indicates the numbers of the load case, load group or load combination whose 
internal forces result in the maximum design ratio on the member. 

Forces / Moments 
For each member, the governing normal and shear forces as well as the torsional and bend-
ing moments are displayed. 

Design according to Formula 
The final column informs you about the design types and equations by which the designs 
have been performed according to the selected standard. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.7: Table 3.2 Governing Internal Forces by Set of Members 

This table contains the governing internal forces that result in the maximum ratios in each 
set of members. 

4.8 Member Slendernesses 

 
Figure 4.8: Table 3.3 Member Slendernesses 
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The table lists the effective slendernesses of the designed members for both principal direc-
tions depending on the type of load and compares them to the values that have been de-
fined in the Details dialog box (see chapter 3.1.5, page 33). This table is displayed only for 
information because no stability design of slendernesses is intended. 

Members of the member type "Tension" are not included in this table. 

4.9 Parts List by Member 
Finally, RF-TIMBER Pro provides a summary of cross-sections contained in the design case. 

 
Figure 4.9: Table 4.1 Parts List by Member 

By default, the list contains only the designed members. If you want to display a parts list 
for all members of the structure, select the corresponding option in the Other tab of the 
Details dialog box (see Figure 3.5, page 33). To open the dialog box, use the [Details] but-
ton shown on the left. 

Part No. 
The program assigns automatically part numbers for similar members. 

Cross-section 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows for each part how many similar members are used. 

Length 
This column displays the length of an individual member. 

Total Length 
This column shows the product that is determined from the two previous columns. 
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Surface Area 
The program indicates the surface area of the respective parts in relation to the total length. 
The surface area is determined from the Surface of the cross-sections. You can find and 
check the relevant entry in the cross-section information, available in table 1.3 and tables 
2.1 to 2.5 (see Figure 2.12, page 18). 

Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Unit Weight 
The Unit Weight of the cross-section represents the mass in relation to the length of one 
meter. For tapered cross-sections, the program averages both cross-section properties. 

Weight 
The values of this column are determined from the product of the entries in column C and G. 

Total Weight 
The final column indicates the total weight of the respective part. 

Sum 
At the bottom of the list, you find a summary showing the sums of column B, D, E, F and I. 
The results output in the Tot Weight column gives information about the overall timber 
mass that is required. 

4.10  Parts List by Set of Members 

 
Figure 4.10: Table 4.2 Parts List by Set of Members 

The final table is displayed when you have selected at least one set of members for the de-
sign. It offers you a summarizing parts list for an entire structural group, e.g. a chord). 

Details on the table columns can be found in the previous chapter 4.9. When different 
cross-sections are used in the set of members, the program averages the surface area, the 
volume and the unit weight. 
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5.  Results Evaluation 
When the design is complete, several options are available for the results evaluation. The 
buttons below the first table part can be helpful for the evaluation process. 

 
Figure 5.1: Buttons for results evaluation 

The buttons are reserved for the following functions: 

Button Description Function 

 
Ultimate Limit 
State Designs 

Turns on and off the results of the ultimate limit state 
design 

 
Serviceability Limit 
State Designs 

Turns on and off the results of the serviceability limit 
state design 

 
Fire Protection  
Designs 

Turns on and off the results of the fire protection  
design 

 Show Color Bars 
Turns on and off the colored reference scales in the 
results tables 

 Exceeding 
Displays only rows where the ratio is more than 1, 
thus the design is failed 

 
Show Result  
Diagrams 

Opens the window Result Diagram on Member  
 chapter 5.2, page 49 

 View mode Jumps to the RFEM work window to change the view 

 Member selection 
Enables the selection of a member in the RFEM work 
window to show its results in the table 

Table 5.1: Buttons of results tables 2.1 to 2.5 
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5.1 Results in the RFEM Model 
To evaluate the design results, you can also use the RFEM work window. 

RFEM background graphic and view mode 
The RFEM graphic in the background may be useful when you want to check the position of 
a particular member in the model. The member that is selected in the RF-TIMBER Pro results 
table is highlighted in the selection color in the RFEM background graphic. In addition, an 
arrow indicates the member's x-location that is displayed in the active table row. 

 
Figure 5.2: Indication of the member and the current Location x in the RFEM model 

If you move the RF-TIMBER Pro window to another place in the display and you still cannot 
see the graphic clearly, use the button [Jump to Graphics] to activate the view mode: The 
RF-TIMBER Pro window will be hidden so that you can adjust the view appropriately in the 
RFEM user interface. The view mode provides the functions of the View menu, for example 
zooming, moving or rotating the display. 

Click [Back] to return to the add-on module RF-TIMBER Pro. 
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RFEM work window 
It is also possible to visualize the design ratios directly in the structural model: Click the 
[Graphic] button to quit the add-on module RF-TIMBER Pro. The ratios are displayed in the 
RFEM work window like internal forces of a load case. 

To turn the display of design results on or off, use the button [Results on/off] shown on the 
left. To display the result values in the graphic, use the toolbar button [Show Result Values] 
to the right. 

As the RFEM tables are of no relevance for the evaluation of the RF-TIMBER Pro results, you 
may deactivate them. 

The design cases can be set as usual by means of the list in the RFEM menu bar. 

The graphical display of results can be set in the Display navigator, by opening the Results 
folder and selecting the Members entry. The ratios are drawn Two-Colored by default. 

 
Figure 5.3: Display navigator: Results → Members 

In case of a multicolor representation (options Cross-sections or Colored), the color panel is 
available, providing common control functions. The panel functions are described in detail 
in the RFEM manual, chapter 4.4.6, page 77. 

 
Figure 5.4: Design ratios with display option Cross-sections 



5  Results Evaluation 

 48 Program RF-TIMBER Pro © 2011 Ing. Software Dlubal 

 

 

In the Factors tab of the panel, you can scale the design results, as you know it from the 
member internal forces. If you enter the factor 0 in the input field Member Diagrams, the 
results will be represented without scaling but with an increased line thickness. 

 

Figure 5.5: Panel tab Factors  

The graphics can be transferred to the printout report like RFEM graphics (see chapter 6.2, 
page 52). 

To return to the add-on module RF-TIMBER Pro, use the [RF-TIMBER Pro] button in the  
panel.  
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5.2 Result Diagrams 
The result diagram can be useful if you want to see a member's result distribution displayed 
graphically. Select the member (or set of members) in the RF-TIMBER Pro results table by 
placing the cursor in the corresponding table row and open the result diagram by clicking 
the button shown on the left. You find the button below the first table part of the results 
table (see Figure 5.1, page 45). 

The result diagrams are available in the RFEM graphic. To display the diagrams, 

select Result Diagrams on Selected Members on the Results menu, 

or use the button in the RFEM toolbar shown on the left. 

A window opens showing the distribution of design results on the selected member or set 
of members. 

 
Figure 5.6: Dialog box Result Diagram on Member 

Use the list in the toolbar above to choose the relevant RF-TIMBER Pro design case. 

For more detailed information on the dialog box Result Diagram on Member, see the RFEM 
manual, chapter 10.5, page 311. 
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5.3 Filter for Results 
In addition to the RF-TIMBER Pro results tables which already allow for a particular selection 
according to certain criteria because of their structure, you can use the filter options de-
scribed in the RFEM manual to evaluate the RF-TIMBER Pro design results graphically. 

Generally, you can take advantage of already defined partial views (see RFEM manual, chap-
ter 10.9, page 321) used to group objects appropriately. 

Filtering designs 
The ratios can be used easily as filter criteria in the RFEM workspace. To apply this filter 
function, the panel must be displayed. If the panel is not active, 

select Control Panel (Colour scale, Factors, Filter) on the View menu of RFEM 

or use the toolbar button shown on the left. 

The panel is described in the RFEM manual, chapter 4.4.6, page 77. The filter settings for 
the results must be defined in the panel tab Color spectrum. As this tab is not available for 
the two-colored results display, you have to set the display option Colored or Cross-sections 
in the Display navigator. 

 
Figure 5.7: Filtering design ratios with adjusted color spectrum 

For example, if you use a colored results display, you can use the panel to determine that 
only design ratios higher than 0.50 are displayed. Furthermore, the color spectrum can be 
adjusted in such a way that a color range covers a design ratio of 0.05 as shown in the fig-
ure above. 

When you select the option Display Hidden Result Diagram (under Results → Members in 
the Display navigator), you can even display all stress ratio diagrams that do not fulfill the 
conditions. Those diagrams will be represented by dotted lines. 
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Filtering members 
In the Filter tab of the control panel, you can define the numbers of the members whose re-
sults you want to be shown exclusively, which means filtered. The function is described in 
detail in the RFEM manual, chapter 10.9, page 326. 

 
Figure 5.8: Member filter for ratios of bottom chord 

Unlike the partial view function, the structure is now displayed completely in the graphic. 
The figure above shows the ratios in the bottom chord of a truss girder. The remaining 
members are displayed in the model but are shown without design ratios. 
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6.  Printout 
 

6.1 Printout Report 
Similar to RFEM, the program generates a printout report for the RF-TIMBER Pro results that 
can be completed by graphics and descriptions. In the report you can also decide which in-
put and output tables appear in the printout. 

The printout report is described in detail in the RFEM manual. In particular, chapter 11.1.3.4 
Selecting Data of Add-on Modules on page 338 provides information concerning the selec-
tion of input and output data in add-on modules. 

For complex structures with a high number of design cases, it is recommended to split the 
data into several small printout reports which allows for a clearly-arranged printout and a 
faster work. 

6.2 RF-TIMBER Pro Graphic Printout 
Every picture that is displayed in the graphic window of the main program RFEM can be in-
cluded into the printout report. This means that the design ratios displayed in the RFEM 
model can be prepared for the printout, too. The graphics can be integrated in the global 
printout report or sent directly to the printer. Printing graphics is described in detail in the 
RFEM manual, chapter 11.2. 

Designs in the RFEM model 
To print the RF-TIMBER Pro graphic currently displayed in the RFEM work window, 

select Print on the File menu 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print in the toolbar of the main window 

Result diagrams 
In the same way, you can integrate the result diagrams of members into the report by using 
the [Print] button. It is also possible, to print them directly. 

 
Figure 6.2: Button Print in the toolbar of the Result Diagram window 

The following dialog box opens: 
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Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in detail in the RFEM manual, chapter 11.2, page 354. The 
RFEM manual also describes the Options and Color Spectrum tab. 

A graphic from RF-TIMBER Pro that has been integrated in the printout report can be moved 
anywhere within the report by using the drag-and-drop function. In addition, it is possible 
to adjust imported graphics subsequently: Right-click the relevant entry in the navigator of 
the printout report and select Properties in the context menu. The dialog box Graphic 
Printout appears again, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options 
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7.  General Functions 
This chapter describes some menu functions as well as export options for the design results. 

7.1 RF-TIMBER Pro Design Cases 
Members can be arranged in groups for different design cases. In this way, you can com-
bine groups of structural components or analyze members with particular design specifica-
tions (for example changed materials, partial safety factors, optimization). 

It is no problem to analyze the same member or set of members in different design cases. 

The design cases of RF-TIMBER Pro are available in the RFEM work window and can be dis-
played like a load case or load group by means of the toolbar list. 

Create a new RF-TIMBER Pro case 
To create a new design case, 

select New Case on the File menu in the RF-TIMBER Pro add-on module. 

The following dialog box appears. 

 
Figure 7.1: Dialog box New RF-TIMBER Pro-Case 

In this dialog box, enter a No. (which is not yet assigned) and a Description for the new de-
sign case. When you click [OK], table 1.1 General Data opens where you can enter the new 
design data. 

Rename an RF-TIMBER Pro case 
To change the description of a design case subsequently, 

select Rename Case on the File menu in the RF-TIMBER Pro add-on module. 

The dialog box Rename RF-TIMBER Pro-Case appears. 

 
Figure 7.2: Dialog box Rename RF-TIMBER Pro-Case 
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Copy an RF-TIMBER Pro case 
To copy the input data of the current design case, 

select Copy Case on the File menu in the RF-TIMBER Pro add-on module. 

The dialog box Copy RF-TIMBER Pro-Case appears where you can specify the number and 
description of the new case. 

 
Figure 7.3: Dialog box Copy RF-TIMBER Pro-Case 

Delete an RF-TIMBER Pro case 
To delete design cases, 

select Delete Case on the File menu in the RF-TIMBER Pro add-on module. 

In the dialog box Delete Cases, you can select the relevant design case in the Available Cas-
es list to delete it by clicking [OK]. 

 
Figure 7.4: Dialog box Delete Cases 
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7.2 Cross-section Optimization 
As mentioned in chapter 2.3, RF-TIMBER Pro offers you the possibility to optimize cross-
sections. Select the relevant cross-section by ticking its check box in column C or D in table 
1.3 Cross-sections (see Figure 2.10, page 17). 

You can also start the cross-section optimization out of the results tables by using the con-
text menu. 

During the optimization process, RF-TIMBER Pro determines the cross-section within the 
same cross-section table that fulfills the analysis requirements in the most optimal way, that 
means comes as close as possible to the maximum possible ratio specified in the Details dia-
log box (see Figure 3.5, page 33). The required cross-section properties will be determined 
with the RFEM internal forces. If another cross-section proves to be more favorable, it will 
be used for the design. In this case, two cross-sections will be displayed on the right of ta-
ble 1.3 as shown in Figure 7.6, the original cross-section from RFEM and the optimized one. 

A dialog box with detailed specifications appears when you tick the check box for optimiza-
tion. 

 
Figure 7.5: Dialog box Solid Sections - Rectangle : Optimize 

By ticking the check boxes in the Optimize column, you decide which parameter(s) you 
want to modify. The ticked check box enables the Minimal and Maximal columns where you 
specify the upper and lower limits of the parameter. The Increment column determines the 
interval in which the size of this parameter varies during the optimization process. 

If you want to Keep Current Side Proportions, tick the corresponding check box. In addi-
tion, you have to select both parameters for the optimization. 

Please note for the optimization process that the internal forces won't be recalculated au-
tomatically with the changed cross-sections. It is up to you to decide which cross-sections 
should be transferred to RFEM for a recalculation. As a result of optimized cross-sections, 
internal forces may vary considerably because of the changed stiffnesses in the structural 
system. Therefore, it is recommended to recalculate the internal forces after the first opti-
mization and then to optimize the cross-sections again. 

You do not need to transfer the modified cross-sections to RFREM manually: Set table 1.3 
Cross-sections, and then  

select Export All Cross-sections to RFEM on the Edit menu. 
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Also the context menu available in table 1.3 provides options to export optimized cross-
sections to RFEM. 

 
Figure 7.6: Context menu in table 1.3 Cross-sections 

Before the changed cross-sections are transferred to RFEM, a security query appears, be-
cause the transfer requires the deletion of results. When you confirm the query and start 
the [Calculation] in RF-TIMBER Pro, the RFEM internal forces as well as the RF-TIMBER Pro 
designs will be determined and performed in one single calculation run. 

 
Figure 7.7: Query before transfer of modified cross-sections to RFEM 

By using the menu functions described above, you can also reimport the original RFEM 
cross-sections to RF-TIMBER Pro. Please note that this option is only available in table 1.3 
Cross-sections. 

If you optimize a tapered member, the program modifies the member's start and end and 
interpolates the second moments of area for the intermediate locations linearly. As these 
moments are considered with the fourth power, the designs may be inaccurate if the 
depths of the start and end cross-section differ considerably. In this case, it is recommended 
to divide the taper into several single members whose start and end cross-sections have mi-
nor cross-section differences. 
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7.3 Material Export to RFEM 
When you have changed materials in table 1.2 of RF-TIMBER Pro, you can export the modi-
fied materials to RFEM, similar to the export of modified cross-sections. It is also possible to 
import the originally used materials from RFEM. Materials modified in the add-on module 
are highlighted in blue. 

You do not need to transfer the modified materials manually to RFEM. 
Set table 1.2 Materials, and then 

select Export All Materials to RFEM on the Edit menu. 

Also the context menu of table 1.2 provides options to transfer modified materials to RFEM. 

 
Figure 7.8: Context menu of table 1.2 Materials 

Before the changed materials are transferred to RFEM, a security query appears because the 
transfer requires the deletion of results. When you confirm the query and start the [Calcula-
tion] in RF-TIMBER Pro, the RFEM internal forces as well as the TIMBER Pro designs will be 
determined and performed in one single calculation run. 

 
Figure 7.9: Query before transfer of modified materials to RFEM 
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7.4 Units and Decimal Places 
The units and decimal places for RFEM and all add-on modules are managed in one global 
dialog box. In the add-on module RF-TIMBER Pro, you can use the menu to define the units. 
To open the corresponding dialog box, 

select Units and Decimal Places on the Settings menu. 

The program opens the following dialog box that you already know from RFEM. The add-on 
module RF-TIMBER Pro is preset. 

 
Figure 7.10: Dialog box Units and Decimal Places 

The settings can be saved as user profile to reuse them in other structures. The functions 
are described in the RFEM manual, chapter 12.6.2, page 453. 

7.5 Export of Results 
The designs can be provided for other programs in various ways. 

Clipboard 
To copy cells selected in the RF-TIMBER Pro results tables to the clipboard, use the keyboard 
keys [Ctrl]+[C]. To insert the cells, for example in a word processing program, press 
[Ctrl]+[V]. The headers of the table columns won't be transferred. 

Printout report 
The data of the RF-TIMBER Pro add-on module can be printed into the global printout re-
port (see chapter 6.1, page 52) to export them subsequently. Then, in the printout report, 

select Export to RTF File or BauText on the File menu. 

The function is described in detail in the RFEM manual, chapter 11.1.11, page 350. 
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Excel / OpenOffice 
RF-TIMBER Pro provides a function for the direct data export to MS Excel, OpenOffice.org 
Calc or the file format CSV. To open the corresponding dialog box, 

select Export Tables on the File menu in the RF-TIMBER Pro add-on module. 

The following export dialog box appears. 

 
Figure 7.11: Dialog box Export - MS Excel 

When you have selected the relevant parameters, start the export by clicking [OK]. Excel or 
OpenOffice will be started automatically. It is not necessary to run the programs in the 
background. 

 
Figure 7.12: Results in Excel 
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8. Example 
We perform the design according to EN 1995-1-1 for a wood column that is restrained and 
stressed by compression and bending. Moreover, it is supported on the free end in direction 
Y. The example is described in the German timber construction book [8], page 236. 

8.1 Structure and Loads 
Structure 

Cross-section: b/d = 14/22 cm 

Material:  CT C24 

Depth:  h = 3.20 m 

Service class: 1 

LDC:  permanent 

 

Load 

LC 1 Self-weight: F = 45 kN  

LC 2 Wind:  w = 1.5 kN/m  

 

 

 

 

 

 

Figure 8.1: System and loads according to [8] 

Design values 

Nd = 1.35 · F = 1.35 · 45 kN  = 60.75 kN (kmod = 0.6)  

qd = 1.5 · w = 1.5 · 1.5 KN/m = 2.25 kN/m (kmod = 0.9) 
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8.2 Calculation with RFEM 
The system as well as the loads in both load cases are modeled in RFEM as 3D structure. We 
deactivate the automatic consideration of the self-weight when we create LC 1 because it is 
also neglected in the example of the German timber construction book. 

We superimpose the load cases for the basic combination with the corresponding partial 
safety factors in a load combination. They will be calculated according to the linear static 
analysis. For the design in RF-TIMBER Pro it is important to define both load cases with the 
"permanent" criterion. 

RFEM determines the following diagrams of internal forces. 

 
Figure 8.2: Internal forces N, Vz and My 

The analyzed internal forces are equivalent to the ones mentioned in [8], page 237. 
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8.3 Design with RF-TIMBER Pro 
8.3.1 Ultimate Limit State Design 
In table 1.1 General Data, we select the load combination CO1 for the Ultimate Limit State 
design. 

We perform the design according to EN 1995-1-1 with the German national annex DIN. 

 
Figure 8.3: Table 1.1 General Data 

Table 1.2 Materials and table 1.3 Cross-sections present the characteristic stiffnesses of the 
selected material as well as the available cross-section. 

 
Figure 8.4: Table 1.2 Materials 
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Figure 8.5: Table 1.3 Cross-sections 

In table 1.4 we define the load duration and the service class. The factor kmod of CO1 will be 
calculated from the LDC of the contained load cases by taking into account the service 
class. 

 
Figure 8.6: Table 1.4 Load Duration and Service Class 
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In table 1.5 Effective Lengths we specify the buckling lengths of the column. The example 
provides the Euler buckling modes 1 and 3 with the coefficients for effective length βef,y = 
2.0 and βef,z = 0.7. 

 
Figure 8.7 Table 1.5 Effective Lengths - Members 

We start the calculation by clicking the [Calculation] button. 

After the calculation table 2.1 Design by Load Case appears showing the governing design 
results. 

 
Figure 8.8: Table 2.1 Design by Load Case 
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The Details displayed in the lower part of the table correspond to the designs described in 
[8]. 
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Buckling coefficient kc according to [4] section 6.3.2 (intermediate values can be interpolat-
ed linearly): 
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kc,y = 0.301 

Stability analysis 
Design according to [4] eq. (6.23): 
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Shear design 
Design of shear from transverse force according to [4] section 6.1.7: 
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The shear stresses can be determined by the stress point details with the corresponding 
statical moments of area (see Figure 2.12, page 18). 
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8.3.2 Serviceability Limit State Design 

We create another load combination in RFEM with different partial safety factors for the 
serviceability limit state design. 

CO2 = 1.0 · LC1/s + 1.0 · LC2/s 

In the add-on module RF-TIMBER Pro, we select the load combination CO2 for the design in 
the Serviceability Limit State tab of table 1.1 General Data. 

 
Figure 8.9: Table 1.1 General Data, tab Serviceability Limit State 

We click the blue check mark button to assign the Design Combination acc. to 2.2.3 (2) winst 
SC to the selected load combination. 

Then, we enter member 1 in table 1.8 Serviceability Data (see the following Figure 8.10). 
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We do not modify the reference length but we restrict the direction to z. As the beam has 
no support in this direction, we select the beam type Cantilever End Free in the list. 

 
Figure 8.10: Table 1.8 Serviceability Data 

We have to change a setting for the control calculation. We use the [Details] button to 
open the dialog box below where we specify our selection in the Serviceability tab: We 
want the deformation to be related to the Undeformed System. 

 
Figure 8.11: Dialog box Details, tab Serviceability 
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In the example of [8] an elastic modulus of 10,000 MN/m2 is applied. Thus, a new material 
with corresponding characteristics would have to be defined in RFEM. However, to simplify 
matters, we use the default value of 11,000 MN/m2 for the following control calculation. 

150
l

IE8
hw

w
y

4

inst ≤
⋅⋅
⋅

=  

150
320

cm13.2cm44.1
10

10
70.12422110008

2.35.1
w

8

14

inst =<=⋅
⋅⋅
⋅

= −

−
 

Design:   1676.0
cm13.2

cm44.1

w

w

itlim

inst <==  

This result is also displayed in the RF-TIMBER Pro results table 2.1 Design by Load Case un-
der the table entry Serviceability Limit State Design. 

 
Figure 8.12: Table 2.1 Design by Load Case 
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